Using Data to Strengthen Your Nursing Home Advocacy

Presented by Richard Mollot & Eric Goldwein
Long Term Care Community Coalition

www.nursinghome411.org
What is the Long Term Care Community Coalition?

- **LTCCC**: Nonprofit organization dedicated to improving care & quality of life for the elderly & adult disabled in long term care (LTC). **Home to the local LTCOP in the Hudson Valley, NY.**

- **Our focus**: People who live in nursing homes & assisted living.

- **What we do**:
  - Policy analysis and systems advocacy in NYS & nationally;
  - Education of consumers and families, LTC Ombudsmen and other stakeholders.
Why is This Information Useful?

- **To Support Advocacy in a Nursing Home**
  - Data can support advocacy about concerns such as antipsychotic drugging, pressure ulcers, falls, etc...
  - Data can indicate low staffing and support advocacy for improvement.
  - Data enable comparisons between a facility and others in the community or state or nation.

- **To Support Broader and Systemic Advocacy**
  - Highlight and substantiate concerns, such as low staffing or high drugging or pressure ulcer rates, with state and federal politicians, news reporters, etc...
  - Demonstrate and substantiate concerns for state enforcement agencies, Medicaid Fraud Control Units, state auditors, and the public.
  - Support requests for funding by showing the need of the work you do.
What Will We Be Talking About TODAY?

- **Nursing Home Compare:**
  - Looking up nursing homes
  - Understanding the information provided
  - Changes underway to (hopefully) improve Nursing Home Compare.

- **Digging Deeper on...**
  - Nursing Home Compare
  - ProPublica’s Nursing Home Inspect
  - LTCCC’s website, [www.nursinghome411.org](http://www.nursinghome411.org).

- **Mapping Nursing Home Ratings & Info.**

- **Resources**
Intro to Nursing Home Compare
NH Compare & the 5 Star Rating System: www.medicare.gov/nursinghomecompare

Background

- Nursing Home Compare provides information on every licensed nursing home in the U.S.

- While it is not perfect, we consider it to be the most reliable and useful resource for information on a nursing home’s quality.
Nursing Home Compare:
http://www.medicare.gov/nursinghomecompare/

Search by...
- State name
- Nearest town or city
- Zip Code
NH Compare & the 5 Star Rating System
Where Should Momma Go?

Study found that rating systems “are better at identifying problem facilities than potentially good homes.”
**NH Compare Inspections: Highland Rehab.**

---

**Nursing Home Profile**

**Overall Rating:** Below Average

**Health Inspections**

- **Date of Most Recent Standard Health Inspection:** 01/21/2017
- **Total Number of Health Citations:** 0
- **Average Number of Health Citations in New York:** 5.0
- **Average Number of Health Citations in the United States:** 7.2
- **Date(s) of Complaint Inspection(s) Between 11/1/2016 - 10/31/2017:** No Complaint Inspections
- **Number of Complaints in the Past 3 Years that Resulted in a Citation:** 4
- **Number of Times in the Past 3 Years a Facility-Reported Issue Resulted in a Citation:** 0

---

**View all health inspection details**

---

[View Full Report](https://www.medicare.gov/nursinghomecompare)
Staffing: Highland Rehab.

<table>
<thead>
<tr>
<th>Staffing rating</th>
<th>Highland Rehabilitation and Nursing Center</th>
<th>New York Average</th>
<th>National Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total number of residents</td>
<td>90</td>
<td>167.3</td>
<td>85.4</td>
</tr>
<tr>
<td>Total number of licensed nurse staff hours per resident per day</td>
<td>1 hour and 55 minutes</td>
<td>1 hour and 37 minutes</td>
<td>1 hour and 41 minutes</td>
</tr>
<tr>
<td>RN hours per resident per day</td>
<td>42 minutes</td>
<td>45 minutes</td>
<td>50 minutes</td>
</tr>
<tr>
<td>LPN/LVN hours per resident per day</td>
<td>1 hour and 13 minutes</td>
<td>51 minutes</td>
<td>51 minutes</td>
</tr>
<tr>
<td>CNA hours per resident per day</td>
<td>2 hours and 40 minutes</td>
<td>2 hours and 20 minutes</td>
<td>2 hours and 27 minutes</td>
</tr>
</tbody>
</table>
We do not generally give much credence to quality measure ratings, since most of them are self-reported by the facility and unverified for accuracy by the state or federal governments.

For example, this is a two star facility. Yet, it has - as shown on earlier slide – four stars for QMs. What does that mean?
Ownership: Highland Rehab.
Note: States are also required to have nursing home information websites. The SoDs on those websites are required to include Plans of Correction.
NH Compare: Updates & Improvements

Quality Measures.

- As noted earlier, we have long been concerned about the validity of QMs. A 2014 investigation in *The New York Times* found “that even nursing homes with a history of poor care rate highly in the areas that rely on self-reported data.”

- To address these concerns, CMS is now using the following in the Five-Star Quality Rating System:
  - Percentage of short-stay residents who were successfully discharged to the community;
  - Percentage of short-stay residents who have had an outpatient emergency department visit; and
  - Percentage of short-stay residents who were re-hospitalized after a nursing home admission.

Staffing.

As of 2016, CMS began requiring nursing homes to report their staffing based on auditable, payroll-based journal (PBJ) data. These data were first made available to the public in November 2017 on a separate database and were integrated into NH Compare last year.

New Abuse Icon.

As of October 23, 2019, if facility is cited with harm-level abuse deficiency within past year (G-I) or potential for harm deficiency within past 2 years (D-F).
NH Compare Datasets
Digging Deeper on NH Compare & Beyond: www.data.medicare.gov
Datasets include information for every nursing home. Topics include:

- Health deficiencies
- MDS Quality Measures (like antipsychotic drugging rates, pressure ulcers, falls, etc...)
- Ownership
- Penalty counts
- Staffing (risk-adjusted)
- Star ratings

Each dataset includes searchable identifying information, such as:

- Nursing home name
- State
- City
- County
- Address
NH Compare Dataset Example:
Health Deficiencies (Citations for Failure to Meet Minimum Standards)
A federal government website managed by the Centers for Medicare & Medicaid Services, 7500 Security Boulevard, Baltimore, MD 21244

Health Deficiencies
A list of all health deficiencies currently listed on Nursing Home Compare, including the nursing home that received the deficiency, the required corrective action, deficiency type, the number of days, and resolution. This is a subset of the data.medicare.gov dataset.

<table>
<thead>
<tr>
<th>Federal Provider Number</th>
<th>Provider Name</th>
<th>Provider Address</th>
<th>Provider City</th>
<th>Provider State</th>
<th>Provider Zip Code</th>
<th>Survey Date</th>
<th>Survey Type</th>
<th>Deficiency Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>015016</td>
<td>A'THENS HEALTH AND REHABILITATION L...</td>
<td>617 WEST MARKET STREET</td>
<td>ATHENS</td>
<td>AL</td>
<td>35611</td>
<td>06/01/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015037</td>
<td>BLUE RIDGE HEALTHCARE WINDWOOD</td>
<td>3312 WOODLEY ROAD</td>
<td>MONTGOMERY</td>
<td>AL</td>
<td>36116</td>
<td>11/20/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015065</td>
<td>PRATTVILLE HEALTH AND REHABILITAT....</td>
<td>601 JAMES MAP</td>
<td>PRATTVILLE</td>
<td>AL</td>
<td>36066</td>
<td>10/20/2016</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015105</td>
<td>ASHLAND PLACE HEALTH AND REHABILIT..., 148 TUSCALOOSA ST</td>
<td>MOBILE</td>
<td>MOBILE</td>
<td>AL</td>
<td>35607</td>
<td>10/20/2016</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015119</td>
<td>BLUE RIDGE HEALTHCARE SELMA</td>
<td>150 HOSPITAL ROAD</td>
<td>SELMA</td>
<td>AL</td>
<td>36701</td>
<td>10/06/2019</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015128</td>
<td>NHC HEALTHCARE, MOULTON</td>
<td>300 HOSPITAL STREET</td>
<td>MOULTON</td>
<td>AL</td>
<td>35600</td>
<td>09/14/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015132</td>
<td>DIVERSCARE OF OXFORD</td>
<td>1130 S HALE STREET</td>
<td>OXFORD</td>
<td>AL</td>
<td>36023</td>
<td>09/19/2018</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015142</td>
<td>LINOVILLE HEALTH AND REHABILITATION...</td>
<td>88073 HIGHWAY 9</td>
<td>LINOVILLE</td>
<td>AL</td>
<td>36266</td>
<td>08/17/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015149</td>
<td>SUNSET MANOR</td>
<td>251 SUNSET PLACE</td>
<td>GUN</td>
<td>AL</td>
<td>35663</td>
<td>09/05/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015195</td>
<td>VILLAGE AT COOK SPRINGS SKILLED NUR., 415 COOK SPRINGS</td>
<td>PELL CITY</td>
<td>AL</td>
<td>35125</td>
<td>07/01/2017</td>
<td>Health</td>
<td>F</td>
<td></td>
</tr>
<tr>
<td>015227</td>
<td>GENERATIONS OF VERNON, LLC</td>
<td>1050 CONNALEND ROAD</td>
<td>VERNON</td>
<td>AL</td>
<td>35592</td>
<td>06/27/2018</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015360</td>
<td>OAKS ON PARMAWOOD SKILLED NURSG...</td>
<td>2625 LAUREL OAK DRIVE</td>
<td>BESSEMER</td>
<td>AL</td>
<td>35022</td>
<td>07/18/2019</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015369</td>
<td>OAKS ON PARMAWOOD SKILLED NURSG...</td>
<td>2625 LAUREL OAK DRIVE</td>
<td>BESSEMER</td>
<td>AL</td>
<td>35022</td>
<td>05/25/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015376</td>
<td>DIVERSCARE OF WILDFIELD</td>
<td>104 COUNTY HWY 14</td>
<td>WILDFIELD</td>
<td>AL</td>
<td>35594</td>
<td>08/28/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015400</td>
<td>MEADOWVIEW NURSING CENTER</td>
<td>7300 OAK HEIGHT 78 EAST</td>
<td>PELL CITY</td>
<td>AL</td>
<td>35128</td>
<td>01/01/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015422</td>
<td>TLC NURSING CENTER</td>
<td>212 ELLEN STREET</td>
<td>ONGO'NTA</td>
<td>AL</td>
<td>35121</td>
<td>08/10/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015443</td>
<td>ROBERTSDALE REHABILITATION &amp; HEALTH...</td>
<td>18700 U.S. HIGHWAY 90</td>
<td>ROBERTSDALE</td>
<td>AL</td>
<td>35657</td>
<td>06/15/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015456</td>
<td>GULF COAST HEALTH AND REHABILITATI...</td>
<td>8002 GREGORY ROAD</td>
<td>MOBILE</td>
<td>AL</td>
<td>36695</td>
<td>11/08/2018</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015463</td>
<td>KNOLLWOOD HEALTHCARE</td>
<td>315-A KNOLLWOOD DRIVE</td>
<td>MOBILE</td>
<td>AL</td>
<td>36693</td>
<td>10/19/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>015467</td>
<td>TRUSSVILLE HEALTH &amp; REHABILITATION...</td>
<td>115 WATERSOON PARKWAY</td>
<td>TRUSSVILLE</td>
<td>AL</td>
<td>35173</td>
<td>04/17/2017</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>025015</td>
<td>WRANGELL MEDICAL CENTER LLC</td>
<td>P.O. BOX 1081</td>
<td>WRANGELL</td>
<td>AK</td>
<td>99929</td>
<td>04/30/2018</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>025024</td>
<td>PROVIDENCE SEWARD MED &amp; CARE CENTER...</td>
<td>2203 OAK STREET (P.O. BOX 430)</td>
<td>SEWARD</td>
<td>AK</td>
<td>99664</td>
<td>10/09/2018</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>025025</td>
<td>PRESTIGE CARE &amp; REHAB CENTER OF ANI...</td>
<td>100 CENTENNIAL DRIVE</td>
<td>ANCHORAGE</td>
<td>AK</td>
<td>99504</td>
<td>06/08/2018</td>
<td>Health</td>
<td>F</td>
</tr>
<tr>
<td>025025</td>
<td>PRESTIGE CARE &amp; REHAB CENTER OF ANI...</td>
<td>100 CENTENNIAL DRIVE</td>
<td>ANCHORAGE</td>
<td>AK</td>
<td>99504</td>
<td>05/04/2017</td>
<td>Health</td>
<td>F</td>
</tr>
</tbody>
</table>
Health deficiency data available at
https://data.medicare.gov/Nursing-Home-Compare/Health-Deficiencies/r5ix-sfxw

Data include:

- Survey date
- Deficiency number & description (example: F-371, “Store, cook, and serve food in a safe and clean way”)
- Scope & severity rating for the deficiency
Health deficiency data

Excel file demonstration: Deficiencies Displayed on NH Compare & US Nursing Home Food Safety Deficiencies.
Nursing Home Staffing Data on www.data.cms.gov
What are the PBJ data and why are they so important?

- Historically, nursing homes only reported their staffing levels once a year, for the two weeks prior to their annual survey. These data were not audited by either the states or federal government.

- Due to concerns that many nursing homes were inflating their staffing numbers (surprise!), the 2010 Affordable Care Act required that nursing homes report their staffing numbers every day of the year, based on their **auditable payroll records**.

- This requirement was implemented in 2016. Public reporting began in 2017. In 2018, CMS began including the names of the city and county for each nursing home, making these data much more useful for people who are searching for information on or evaluating facilities in their communities.

- Data are provided for every facility for every day, in quarterly (3 month) files. They include daily hours for: RN, LPN, CNA, nursing staff assigned to provide care or administrative work, nursing staff who are permanent or contract, plus medical directors, pharmacist, activities, and therapy staff.
The “raw” data files enable...

- View all data for everyday of the quarter for every type of staffing included in the database.
- Search for specific days, like weekends or holidays.

They do not provide information by shift.
Nursing Home Staffing Data on www.nursinghome411.org
NH411 Data: Staffing

Every quarter, following publication of the raw data by CMS, LTCCC downloads the data files, averages the staffing rates for the quarter for select categories, and publishes them in easy-to-use, searchable, sortable, files. These files are available to you at www.nursinghome411.org.
Sortable Facility-Level Data on Direct Care Staff Based on Auditable PBJ Data. (Each column represents the average for the nursing home for the 1st quarter of 2019).
## NH411 Data: Staffing

<table>
<thead>
<tr>
<th>State</th>
<th>Provider Name</th>
<th>City</th>
<th>County</th>
<th>MDS Census</th>
<th>RN Hours</th>
<th>RN Hours Contract</th>
<th>Percent RN Hours Contract</th>
<th>LPN Hours</th>
<th>LPN Hours Contract</th>
<th>Percent LPN Hours Contract</th>
<th>CNA Hours</th>
<th>CNA Hours Contract</th>
<th>Percent CNA Hours Contract</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD</td>
<td>CITIZENS CARE AND REHABILITATION CENTER OF FRED FREDERICK</td>
<td>Frederick</td>
<td></td>
<td>162.4</td>
<td>71.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>145.7</td>
<td>0.0</td>
<td>0.0%</td>
<td>350.3</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>CITIZENS CARE CENTER</td>
<td>Havre De Gr] Harford</td>
<td></td>
<td>136.1</td>
<td>58.4</td>
<td>0.0</td>
<td>0.0%</td>
<td>164.0</td>
<td>6.1</td>
<td>3.7%</td>
<td>275.0</td>
<td>2.7</td>
<td>1.0%</td>
</tr>
<tr>
<td>MD</td>
<td>CLINTON HEALTHCARE CENTER</td>
<td>Clinton</td>
<td>Prince Georg</td>
<td>254.6</td>
<td>103.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>191.3</td>
<td>0.0</td>
<td>0.0%</td>
<td>443.4</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>COFFMAN NURSING HOME</td>
<td>Hagerstown</td>
<td>Washington</td>
<td>49.7</td>
<td>25.3</td>
<td>0.0</td>
<td>0.0%</td>
<td>21.2</td>
<td>0.0</td>
<td>0.0%</td>
<td>136.3</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>COLLINGSWOOD REHABILITATION AND HEALTHCARE CENTER ROCKVILLE</td>
<td>Montgomery</td>
<td></td>
<td>154.1</td>
<td>41.9</td>
<td>0.0</td>
<td>0.0%</td>
<td>110.2</td>
<td>0.0</td>
<td>0.0%</td>
<td>367.4</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>COLLINGTON EPISCOPAL LIFE CARE</td>
<td>Mitchellville</td>
<td>Prince Georg</td>
<td>34.7</td>
<td>35.4</td>
<td>0.0</td>
<td>0.0%</td>
<td>50.9</td>
<td>0.0</td>
<td>0.0%</td>
<td>86.3</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>COPPER RIDGE</td>
<td>Sykesville</td>
<td>Carroll</td>
<td>58.5</td>
<td>24.7</td>
<td>0.0</td>
<td>0.0%</td>
<td>42.3</td>
<td>0.0</td>
<td>0.0%</td>
<td>172.7</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>CORSICA HILLS CENTER</td>
<td>Centreville</td>
<td>Anne Queen</td>
<td>98.4</td>
<td>56.5</td>
<td>0.0</td>
<td>0.0%</td>
<td>73.1</td>
<td>4.3</td>
<td>5.8%</td>
<td>177.2</td>
<td>48.1</td>
<td>27.2%</td>
</tr>
<tr>
<td>MD</td>
<td>COURTLAND, LLC</td>
<td>Baltimore</td>
<td></td>
<td>139.2</td>
<td>105.5</td>
<td>0.1</td>
<td>0.1%</td>
<td>114.7</td>
<td>0.0</td>
<td>0.0%</td>
<td>284.6</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>CRESCENT CITIES NURSING &amp; REHABILITATION CENTER RIVERDALE</td>
<td>Prince Georg</td>
<td></td>
<td>135.7</td>
<td>82.7</td>
<td>3.4</td>
<td>4.1%</td>
<td>123.7</td>
<td>8.3</td>
<td>6.7%</td>
<td>258.8</td>
<td>11.7</td>
<td>4.5%</td>
</tr>
<tr>
<td>MD</td>
<td>CROFTON CONVALESCENT CENTER</td>
<td>Crofton</td>
<td>Anne Arundel</td>
<td>163.2</td>
<td>117.7</td>
<td>0.0</td>
<td>0.0%</td>
<td>117.8</td>
<td>0.0</td>
<td>0.0%</td>
<td>311.7</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>CROMWELL CENTER</td>
<td>Baltimore</td>
<td></td>
<td>118.1</td>
<td>86.8</td>
<td>0.0</td>
<td>0.0%</td>
<td>82.7</td>
<td>0.0</td>
<td>0.0%</td>
<td>217.9</td>
<td>0.9</td>
<td>0.4%</td>
</tr>
<tr>
<td>MD</td>
<td>CUMBERLAND HEALTHCARE CENTER</td>
<td>Cumberland</td>
<td>Alleghany</td>
<td>114.5</td>
<td>34.1</td>
<td>0.0</td>
<td>0.0%</td>
<td>86.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>188.1</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>DEER'S HEAD CENTER</td>
<td>Salisbury</td>
<td>Wincoma</td>
<td>38.2</td>
<td>68.8</td>
<td>6.0</td>
<td>8.7%</td>
<td>52.6</td>
<td>17.5</td>
<td>31.3%</td>
<td>174.4</td>
<td>12.0</td>
<td>6.9%</td>
</tr>
<tr>
<td>MD</td>
<td>DENNETT ROAD MANOR</td>
<td>Oakland</td>
<td>Garrett</td>
<td>94.7</td>
<td>45.8</td>
<td>0.0</td>
<td>0.0%</td>
<td>56.8</td>
<td>0.0</td>
<td>0.0%</td>
<td>237.0</td>
<td>6.6</td>
<td>2.8%</td>
</tr>
<tr>
<td>MD</td>
<td>DEVIN MANOR NURSING AND REHABILITATION CENTRE CUMBERLAND Alleghany</td>
<td>Oak Park</td>
<td></td>
<td>104.0</td>
<td>67.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>48.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>199.7</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>DOCTORS COMMUNITY REHABILITATION AND PATIENT LANCASHIRE</td>
<td>Prince Georg</td>
<td></td>
<td>125.5</td>
<td>102.7</td>
<td>0.0</td>
<td>0.0%</td>
<td>130.5</td>
<td>0.0</td>
<td>0.0%</td>
<td>239.9</td>
<td>2.8</td>
<td>1.2%</td>
</tr>
<tr>
<td>MD</td>
<td>EGGLE NURSING HOME</td>
<td>Lonaconing</td>
<td>Alleghany</td>
<td>62.6</td>
<td>27.5</td>
<td>0.0</td>
<td>0.0%</td>
<td>32.6</td>
<td>0.0</td>
<td>0.0%</td>
<td>135.9</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>ELKTON NURSING AND REHABILITATION CENTER</td>
<td>Elkton</td>
<td>Cecil</td>
<td>167.8</td>
<td>91.2</td>
<td>0.0</td>
<td>0.0%</td>
<td>123.1</td>
<td>2.9</td>
<td>2.4%</td>
<td>234.0</td>
<td>17.9</td>
<td>7.6%</td>
</tr>
<tr>
<td>MD</td>
<td>ELLICOTT CITY HEALTH &amp; REHABILITATION CENTER</td>
<td>Elllicott City</td>
<td>Howard</td>
<td>174.6</td>
<td>73.9</td>
<td>0.0</td>
<td>0.0%</td>
<td>151.5</td>
<td>0.0</td>
<td>0.0%</td>
<td>325.3</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>ENCORE AT TURF VALLEY</td>
<td>Elllicott City</td>
<td>Howard</td>
<td>80.8</td>
<td>61.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>67.9</td>
<td>0.0</td>
<td>0.0%</td>
<td>161.5</td>
<td>1.3</td>
<td>0.8%</td>
</tr>
<tr>
<td>MD</td>
<td>FAHRENHEIT-KEEDY MEMORIAL HOME</td>
<td>Boonsboro</td>
<td>Washington</td>
<td>91.6</td>
<td>37.8</td>
<td>0.0</td>
<td>0.0%</td>
<td>118.3</td>
<td>0.0</td>
<td>0.0%</td>
<td>188.5</td>
<td>5.4</td>
<td>2.9%</td>
</tr>
<tr>
<td>MD</td>
<td>FAIRFIELD NURSING &amp; REHABILITATION CENTER</td>
<td>Crownsville</td>
<td>Anne Arundel</td>
<td>82.5</td>
<td>34.9</td>
<td>0.0</td>
<td>0.0%</td>
<td>75.6</td>
<td>0.0</td>
<td>0.0%</td>
<td>144.9</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>FAIRHAVEN, INC</td>
<td>Sykesville</td>
<td>Carroll</td>
<td>61.9</td>
<td>26.1</td>
<td>0.0</td>
<td>0.0%</td>
<td>52.4</td>
<td>0.0</td>
<td>0.0%</td>
<td>129.9</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>FAIRLAND CENTER</td>
<td>Silver Spring</td>
<td>Montgomery</td>
<td>76.7</td>
<td>48.8</td>
<td>0.3</td>
<td>0.6%</td>
<td>90.9</td>
<td>0.1</td>
<td>0.1%</td>
<td>158.6</td>
<td>49.6</td>
<td>31.3%</td>
</tr>
<tr>
<td>MD</td>
<td>FAYETTE HEALTH AND REHABILITATION CENTER</td>
<td>Baltimore</td>
<td></td>
<td>147.6</td>
<td>58.8</td>
<td>0.0</td>
<td>0.0%</td>
<td>137.9</td>
<td>0.0</td>
<td>0.0%</td>
<td>294.8</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>MD</td>
<td>FOREST HAVEN NURSING AND REHABILITATION CTR</td>
<td>Catonsville</td>
<td>Baltimore</td>
<td>145.8</td>
<td>34.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>99.3</td>
<td>0.0</td>
<td>0.0%</td>
<td>300.7</td>
<td>0.0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Provider Name</td>
<td>City</td>
<td>County</td>
<td>Non-Care Staff</td>
<td>MDS Census</td>
<td>Administrator Hours</td>
<td>Medical Director Hours</td>
<td>Pharmacist Hours</td>
<td>Dietitian Hours</td>
<td>Hours Qualified Activities</td>
<td>Hours Other Activities</td>
<td>Total Hours</td>
<td>Average Activities Staff Hours Per Resident Day</td>
<td>Hours Social Work Staff Hours Per Day</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------</td>
<td>------------</td>
<td>----------------</td>
<td>------------</td>
<td>---------------------</td>
<td>------------------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>---------------------------</td>
<td>------------------------</td>
<td>------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>ALEGANY HEALTH NURSING AND REHAB</td>
<td>Cumberland</td>
<td>Allegany</td>
<td>30</td>
<td>129.2</td>
<td>5.1</td>
<td>0.6</td>
<td>0.4</td>
<td>3.1</td>
<td>5.6</td>
<td>17.1</td>
<td>27.7</td>
<td>0.2</td>
<td>5.6</td>
</tr>
<tr>
<td>ANCHORAGE HEALTHCARE CENTER</td>
<td>Salisbury</td>
<td>Wicomico</td>
<td>30</td>
<td>104.6</td>
<td>39.6</td>
<td>0.1</td>
<td>0.6</td>
<td>2.9</td>
<td>0.0</td>
<td>12.0</td>
<td>12.0</td>
<td>0.1</td>
<td>5.4</td>
</tr>
<tr>
<td>ARCOULA HEALTH AND REHABILITATION CENTER</td>
<td>Silver Spring</td>
<td>Montgomery</td>
<td>30</td>
<td>103.6</td>
<td>0.1</td>
<td>0.4</td>
<td>0.9</td>
<td>1.5</td>
<td>0.1</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ARLINGTON WEST CARE CENTER</td>
<td>Baltimore</td>
<td>Baltimore City</td>
<td>30</td>
<td>72.9</td>
<td>3.6</td>
<td>0.8</td>
<td>0.7</td>
<td>31.8</td>
<td>11.2</td>
<td>6.0</td>
<td>17.2</td>
<td>0.2</td>
<td>5.4</td>
</tr>
<tr>
<td>ASBURY SOLOMONS</td>
<td>Calver</td>
<td>38.1</td>
<td>0.0</td>
<td>0.1</td>
<td>0.1</td>
<td>0.5</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>AUGSBURG LUTHERAN HOME</td>
<td>Baltimore</td>
<td>38.1</td>
<td>0.0</td>
<td>0.1</td>
<td>0.1</td>
<td>0.5</td>
<td>3.7</td>
<td>9.9</td>
<td>8.7</td>
<td>18.6</td>
<td>0.1</td>
<td>9.6</td>
<td>9.6</td>
</tr>
<tr>
<td>AURORA SENIOR LIVING OF MANHATTOW INC</td>
<td>Princess Anne</td>
<td>Somerset</td>
<td>30</td>
<td>113.7</td>
<td>5.6</td>
<td>0.4</td>
<td>0.3</td>
<td>1.5</td>
<td>5.4</td>
<td>20.8</td>
<td>26.3</td>
<td>0.2</td>
<td>5.4</td>
</tr>
<tr>
<td>AUTUMN LAKE HEALTHCARE AT DENTON</td>
<td>Denton</td>
<td>Caroline</td>
<td>30</td>
<td>80.1</td>
<td>5.2</td>
<td>0.4</td>
<td>0.4</td>
<td>0.0</td>
<td>16.6</td>
<td>4.3</td>
<td>21.0</td>
<td>0.3</td>
<td>6.9</td>
</tr>
<tr>
<td>AUTUMN LAKE HEALTHCARE AT ALICE MANOR</td>
<td>Baltimore</td>
<td>Baltimore City</td>
<td>30</td>
<td>95.6</td>
<td>5.5</td>
<td>0.5</td>
<td>0.3</td>
<td>1.4</td>
<td>10.1</td>
<td>3.2</td>
<td>13.4</td>
<td>0.1</td>
<td>6.7</td>
</tr>
<tr>
<td>AUTUMN LAKE HEALTHCARE AT BRIDGEPK</td>
<td>Baltimore</td>
<td>Baltimore City</td>
<td>30</td>
<td>88.4</td>
<td>12.5</td>
<td>0.5</td>
<td>0.3</td>
<td>0.8</td>
<td>0.0</td>
<td>7.1</td>
<td>7.1</td>
<td>0.1</td>
<td>5.9</td>
</tr>
<tr>
<td>AUTUMN LAKE HEALTHCARE AT CHERRY LANE</td>
<td>Laurel</td>
<td>Prince Georges</td>
<td>30</td>
<td>146.3</td>
<td>24.3</td>
<td>0.5</td>
<td>0.6</td>
<td>18.2</td>
<td>2.5</td>
<td>19.2</td>
<td>24.7</td>
<td>0.2</td>
<td>11.4</td>
</tr>
<tr>
<td>AUTUMN LAKE HEALTHCARE AT CHESTERTOWN</td>
<td>Chestertown</td>
<td>Kent</td>
<td>30</td>
<td>72.0</td>
<td>10.8</td>
<td>1.4</td>
<td>0.5</td>
<td>2.0</td>
<td>11.5</td>
<td>7.0</td>
<td>18.3</td>
<td>0.3</td>
<td>6.1</td>
</tr>
<tr>
<td>AUTUMN LAKE HEALTHCARE AT PIKESVILLE</td>
<td>Baltimore</td>
<td>101.4</td>
<td>5.8</td>
<td>0.7</td>
<td>0.7</td>
<td>2.4</td>
<td>5.7</td>
<td>13.8</td>
<td>19.5</td>
<td>0.2</td>
<td>5.7</td>
<td>0.0</td>
<td>5.7</td>
</tr>
<tr>
<td>AUTUMN RIDE AT NORTH OAKS</td>
<td>Baltimore</td>
<td>23.1</td>
<td>0.0</td>
<td>0.3</td>
<td>0.1</td>
<td>1.1</td>
<td>5.3</td>
<td>8.1</td>
<td>13.4</td>
<td>0.6</td>
<td>4.5</td>
<td>0.0</td>
<td>4.5</td>
</tr>
<tr>
<td>BALLINGER CREEK CENTER</td>
<td>Frederick</td>
<td>114.7</td>
<td>4.7</td>
<td>1.1</td>
<td>0.7</td>
<td>6.2</td>
<td>0.0</td>
<td>20.7</td>
<td>20.7</td>
<td>0.2</td>
<td>10.2</td>
<td>0.0</td>
<td>10.2</td>
</tr>
<tr>
<td>BAYLEIGH CHASE INC</td>
<td>Easton</td>
<td>Talbot</td>
<td>30</td>
<td>86.6</td>
<td>10.2</td>
<td>1.0</td>
<td>0.5</td>
<td>5.8</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>10.4</td>
</tr>
<tr>
<td>BAYWOODS OF ANNAPOLIS</td>
<td>Annapolis</td>
<td>Anne Arundel</td>
<td>30</td>
<td>26.0</td>
<td>3.8</td>
<td>0.3</td>
<td>0.1</td>
<td>0.8</td>
<td>0.0</td>
<td>4.8</td>
<td>4.8</td>
<td>0.2</td>
<td>5.4</td>
</tr>
<tr>
<td>BEDFORD COURT HEALTHCARE CENTER</td>
<td>Silver Spring</td>
<td>Montgomery</td>
<td>30</td>
<td>43.7</td>
<td>10.8</td>
<td>0.4</td>
<td>0.0</td>
<td>5.7</td>
<td>4.8</td>
<td>0.0</td>
<td>4.8</td>
<td>0.1</td>
<td>5.4</td>
</tr>
<tr>
<td>BEL AIR HEALTH AND REHABILITATION CENTER</td>
<td>Bel Air</td>
<td>Harford</td>
<td>30</td>
<td>139.4</td>
<td>5.6</td>
<td>0.4</td>
<td>0.7</td>
<td>5.7</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>8.3</td>
</tr>
<tr>
<td>BEL PRE HEALTH &amp; REHABILITATION CENTER</td>
<td>Silver Spring</td>
<td>Montgomery</td>
<td>30</td>
<td>87.6</td>
<td>38.0</td>
<td>0.8</td>
<td>0.3</td>
<td>1.7</td>
<td>5.5</td>
<td>8.5</td>
<td>13.9</td>
<td>0.2</td>
<td>4.6</td>
</tr>
<tr>
<td>BERLIN NURSING AND REHABILITATION CENTER</td>
<td>Berlin</td>
<td>Worcestershire</td>
<td>30</td>
<td>109.8</td>
<td>5.4</td>
<td>0.9</td>
<td>0.0</td>
<td>4.6</td>
<td>5.5</td>
<td>11.2</td>
<td>16.8</td>
<td>0.2</td>
<td>10.9</td>
</tr>
<tr>
<td>BETHESDA HEALTH AND REHABILITATION</td>
<td>Bethesda</td>
<td>171.8</td>
<td>5.5</td>
<td>0.6</td>
<td>0.8</td>
<td>6.6</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>15.9</td>
</tr>
<tr>
<td>BIRCH MANOR HEALTHCARE CENTER</td>
<td>Sykesville</td>
<td>Carroll</td>
<td>30</td>
<td>98.6</td>
<td>5.4</td>
<td>0.5</td>
<td>0.5</td>
<td>3.2</td>
<td>5.4</td>
<td>12.0</td>
<td>17.4</td>
<td>0.2</td>
<td>3.9</td>
</tr>
<tr>
<td>BLUE POINT HEALTHCARE CENTER</td>
<td>Baltimore</td>
<td>Baltimore City</td>
<td>30</td>
<td>127.5</td>
<td>42.7</td>
<td>0.5</td>
<td>0.0</td>
<td>4.0</td>
<td>5.3</td>
<td>9.8</td>
<td>15.1</td>
<td>0.1</td>
<td>7.0</td>
</tr>
<tr>
<td>BRANCH AVENUE Park Care</td>
<td>Pimlico</td>
<td>16.5</td>
<td>5.6</td>
<td>0.5</td>
<td>0.7</td>
<td>6.3</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>10.9</td>
</tr>
</tbody>
</table>
### NH411 Data: Staffing

#### National Care Staff Averages: 3.4 hours of total direct care staff time per resident per day, including 0.5 hours of RN staff time per resident per day.

#### MD State Care Staff Averages: 3.5 hours of total direct care staff time per resident per day, including 0.6 hours of RN staff time per resident per day.

#### Notes on Non-Nursing Staff Data: CMS collects a range of non-nursing staff data including activities staff, various therapy staff, doctors employed by the facility, and medical directors. In an effort to make the data as user-friendly as possible, we have included staffing levels for some of the categories which we believe are most critical to resident care in the Non-Care Staff sheet. To access all of this data, for every nursing home for every day of the quarter, visit [https://data.cms.gov/](https://data.cms.gov/).

For further information on nursing home quality, staffing, and other data, visit our website, [www.nursinghome411.org](http://www.nursinghome411.org).

For further information and technical specification on payroll-based staff reporting requirements, visit the CMS website at [https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/NursingHomeQualityInitiatives/Staffing-Data-Submission-FBU.html](https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/NursingHomeQualityInitiatives/Staffing-Data-Submission-FBU.html).

#### Important Notes re. Average Staffing:
1. Not all facilities are in compliance with the staff reporting requirement. The inability to include the staffing levels maintained in these facilities may skew the average for the US and/or a particular state.
2. The list includes Transitional Care Units and pediatric nursing homes, which generally have significantly higher staffing than a typical nursing home. This, too, will impact state and national averages.
NH411 Data: Staffing

Excel file demonstration
Nursing Home Pressure Ulcer Data on www.nursinghome411.org
NH411 Data: Pressure Ulcer Rates

Nursing Home Pressure Ulcer Rates: Spring 2019

Pressure ulcers are serious medical conditions and one of the important measures of the quality of clinical care in nursing homes. — U.S. Centers for Disease Control & Prevention (CDC).

Click on the following links to download the four quarter average pressure ulcer rates posted on Nursing Home Compare in April 2019. Please note that the absence of a number for a facility means that there was insufficient information available, not that the facility has no residents with pressure ulcers. Please see the Notes tab in each state file for additional information on the data provided.

AK Nursing Home Pressure Ulcer Rates 4Q Average April2019
AL Nursing Home Pressure Ulcer Rates 4Q Average April2019
AR Nursing Home Pressure Ulcer Rates 4Q Average April2019
AZ Nursing Home Pressure Ulcer Rates 4Q Average April2019
CA Nursing Home Pressure Ulcer Rates 4Q Average April2019
CO Nursing Home Pressure Ulcer Rates 4Q Average April2019
CT Nursing Home Pressure Ulcer Rates 4Q Average April2019
DC Nursing Home Pressure Ulcer Rates 4Q Average April2019
DE Nursing Home Pressure Ulcer Rates 4Q Average April2019
## NH411 Data: Pressure Ulcer Rates

<table>
<thead>
<tr>
<th>Provider State</th>
<th>Provider Name</th>
<th>Provider Address</th>
<th>Provider Zip Code</th>
<th>Provider City</th>
<th>Provider State</th>
<th>Pressure Ulcer Rate</th>
<th>Processing Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>KY</td>
<td>MILLCREST HEALTH AND REHAB 1245 AMERII CORBIN</td>
<td>40702</td>
<td>11.6</td>
<td>3/1/19</td>
<td>KY</td>
<td>11.6</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>BARBOURVILLE HEALTH AND 65 MINTON BARRBOURVILLE</td>
<td>40906</td>
<td>17.5</td>
<td>3/1/19</td>
<td>KY</td>
<td>17.5</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>BRADFORD SQUARE GENESIS 1040 US 127 FRANKFORT</td>
<td>40601</td>
<td>2.0</td>
<td>3/1/19</td>
<td>KY</td>
<td>2.0</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>GRAYSON NURSING AND REH 505 WILLIAMS LEITCHFIELD</td>
<td>42754</td>
<td>11.2</td>
<td>3/1/19</td>
<td>KY</td>
<td>11.2</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>HYDEN HEALTH AND REHABIL 6500 US HYDEN</td>
<td>41749</td>
<td>9.4</td>
<td>3/1/19</td>
<td>KY</td>
<td>9.4</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>OAKVIEW NURSING &amp; REHAB 10456 US HWY CALVERT</td>
<td>42029</td>
<td>4.8</td>
<td>3/1/19</td>
<td>KY</td>
<td>4.8</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>RIVERSIDE CARE &amp; REHAB 190 E HWY CALHOUN</td>
<td>42327</td>
<td>4.5</td>
<td>3/1/19</td>
<td>KY</td>
<td>4.5</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>THE WILLOWS AT HARRODSBURG 180 LUCKY H HARRODSBURG</td>
<td>40330</td>
<td>1.0</td>
<td>3/1/19</td>
<td>KY</td>
<td>1.0</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>SIGNATURE HEALTHCARE OF 58 CAL HILL PINE KNOT</td>
<td>42635</td>
<td>5.8</td>
<td>3/1/19</td>
<td>KY</td>
<td>5.8</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>WOLFE COUNTY HEALTH AND 500 HWY 137 CAMPTON</td>
<td>41301</td>
<td>2.5</td>
<td>3/1/19</td>
<td>KY</td>
<td>2.5</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>SIGNATURE HEALTHCARE AT 67 HWY ANNIVILLE</td>
<td>40062</td>
<td>2.1</td>
<td>3/1/19</td>
<td>KY</td>
<td>2.1</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>SOUTH SHORE NURSING &amp; REHAB 1059 US HWY SOUTH SHORE</td>
<td>41175</td>
<td>2.6</td>
<td>3/1/19</td>
<td>KY</td>
<td>2.6</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>BRECKINRIDGE MEMORIAL 1011 OLD H HARDINBURG</td>
<td>40143</td>
<td>13.3</td>
<td>3/1/19</td>
<td>KY</td>
<td>13.3</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>LANDMARK OF LAUREL CREEK 1033 NORTH MANCHESTER</td>
<td>40962</td>
<td>7.3</td>
<td>3/1/19</td>
<td>KY</td>
<td>7.3</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>LIFE CARE CENTER OF LA CENTER 325 W 5TH LA CENTER</td>
<td>42056</td>
<td>7.3</td>
<td>3/1/19</td>
<td>KY</td>
<td>7.3</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>BEAVER DAM NURSING &amp; REHAB 1555 US HWY BEAVER</td>
<td>42320</td>
<td>2.6</td>
<td>3/1/19</td>
<td>KY</td>
<td>2.6</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>OWENTON CENTER 905 HWY 12 OWENTON</td>
<td>40359</td>
<td>3.4</td>
<td>3/1/19</td>
<td>KY</td>
<td>3.4</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>HEARTLAND VILLA CENTER 800 US HWY LEWISPORT</td>
<td>42351</td>
<td>3.5</td>
<td>3/1/19</td>
<td>KY</td>
<td>3.5</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>HEARTSTONE PLACE 506 ALLENSE EKTON</td>
<td>42220</td>
<td>3.8</td>
<td>3/1/19</td>
<td>KY</td>
<td>3.8</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>TRI CITIES NURSING AND REHAB 1501 US HWY CUMBERLAND</td>
<td>40823</td>
<td>10.2</td>
<td>3/1/19</td>
<td>KY</td>
<td>10.2</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>KINGSBROOK LIFECARE CENT 2500 STATE I ASHLAND</td>
<td>41102</td>
<td>4.9</td>
<td>3/1/19</td>
<td>KY</td>
<td>4.9</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>THE SEASONS AT ALEXANDRIA 7341 E ALEX ALEXANDRIA</td>
<td>41001</td>
<td>1.8</td>
<td>3/1/19</td>
<td>KY</td>
<td>1.8</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>SPRING CREEK HEALTH CARE 1400 SOUTH MURRAY</td>
<td>42071</td>
<td>6.9</td>
<td>3/1/19</td>
<td>KY</td>
<td>6.9</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>CHRISTIAN HEALTH CENTER 920 SOUTHWEST LOUISVILLE</td>
<td>40203</td>
<td>13.1</td>
<td>3/1/19</td>
<td>KY</td>
<td>13.1</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>THE PAVILION AT KENTON 401 EAST 20 COVINGTON</td>
<td>41034</td>
<td>6.2</td>
<td>3/1/19</td>
<td>KY</td>
<td>6.2</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>HILLCREST REHABILITATION 3156 BRECK LOUISVILLE</td>
<td>40020</td>
<td>1.4</td>
<td>3/1/19</td>
<td>KY</td>
<td>1.4</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>THE GRANDVIEW NURSING &amp; 64 WATER CAMPBELLSVILLE</td>
<td>42719</td>
<td>9.5</td>
<td>3/1/19</td>
<td>KY</td>
<td>9.5</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>HILLCIDE CENTER 1500 PRIDE MADISONVILLE</td>
<td>42341</td>
<td>11.0</td>
<td>3/1/19</td>
<td>KY</td>
<td>11.0</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>BRIGHTON CORNERSTONE 55 EAST NORMADISONVILLE</td>
<td>42331</td>
<td>5.5</td>
<td>3/1/19</td>
<td>KY</td>
<td>5.5</td>
<td>3/1/19</td>
</tr>
<tr>
<td>KY</td>
<td>LAUREL HEIGHTS HOME FOR 208 WEST TULONDON</td>
<td>40743</td>
<td>0.2</td>
<td>3/1/19</td>
<td>KY</td>
<td>0.2</td>
<td>3/1/19</td>
</tr>
</tbody>
</table>

### About the Data:

Data downloaded on April 13, 2019 from [https://data.medicare.gov/d/1j4n-9y7q/category=Nursing-Home-Compare&view_name=MDS-Quality-Measures](https://data.medicare.gov/d/1j4n-9y7q/category=Nursing-Home-Compare&view_name=MDS-Quality-Measures).

- The data provided are the four quarter average rates of high-risk long stay residents with pressure ulcers as of the above date.
- Some of the facilities have no data in the percentage column. According to CMS, this is due to the number of residents being too small to report.

### For more information:

- [Fact Sheet on Pressure Ulcers](https://nursinghome411.org/fact-sheet-pressure-ulcers/)
- [US Nursing Home Pressure Ulcer Citations](https://nursinghome411.org/enforcement/press-ulcer-citations/)
- [Pressure Ulcer Handout](https://nursinghome411.org/pressure-ulcer-handout/)
- [Pressure Ulcer Issue Alert](https://nursinghome411.org/fccss-issue-alert-pressure-ulcers/)
Nursing Home Pressure Ulcer Citations: Spring 2019

Pressure ulcer are a major concern for nursing home residents and families and, according to the federal Centers for Disease Control and Prevention, a key indicator of the quality and safety provided in a nursing home. We recommend that the information provided here is used in conjunction with information on pressure ulcer rates and staffing rates, available on our Nursing Home Data and Information page, to identify the potential strengths and weaknesses of the care provided in a nursing home. For more information and useful tools to support resident-centered advocacy, please visit our Learning Center.

AK Pressure Ulcer Deficiencies NH Compare March2019
AL Pressure Ulcer Deficiencies NH Compare March2019
AR Pressure Ulcer Deficiencies NH Compare March2019
AZ Pressure Ulcer Deficiencies NH Compare March2019
CA Pressure Ulcer Deficiencies NH Compare March2019
CO Pressure Ulcer Deficiencies NH Compare March2019
CT Pressure Ulcer Deficiencies NH Compare March2019
DC Pressure Ulcer Deficiencies NH Compare March2019
DE Pressure Ulcer Deficiencies NH Compare March2019
FL Pressure Ulcer Deficiencies NH Compare March2019
<table>
<thead>
<tr>
<th>Provider State</th>
<th>Provider Name</th>
<th>Provider Address</th>
<th>Provider City</th>
<th>Provider Zip Code</th>
<th>Survey Date</th>
<th>Deficiency Tag Number</th>
<th>Deficiency Description</th>
<th>Scope Severity Code</th>
<th>Inspection Cycle</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA</td>
<td>ABINGTON MANOR</td>
<td>100 EDELLA ROAD</td>
<td>CLARKS SUMMIT</td>
<td>18411</td>
<td>9/2/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>ABRAMSON RESIDENCE</td>
<td>1425 HORSHAM ROAD</td>
<td>NORTH WALES</td>
<td>154954</td>
<td>7/22/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>ALLIED SERVICES SKILLED NURSING CE 303 SMALLACOMBE DRIVE</td>
<td>SCRANTON</td>
<td>18501</td>
<td>10/5/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>ALLIED SERVICES SKILLED NURSING CE 303 SMALLACOMBE DRIVE</td>
<td>SCRANTON</td>
<td>18501</td>
<td>8/26/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>ALLIED SERVICES TRANSITIONAL REHA 475 MORGAN HIGHWAY</td>
<td>SCRANTON</td>
<td>18508</td>
<td>4/6/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>ASBURY HEALTH CENTER</td>
<td>700 BOWER HILL ROAD</td>
<td>PITTSBURGH</td>
<td>15243</td>
<td>6/23/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>AETHENS HEALTH AND REHABILITATION 200 SOUTH MAIN ST</td>
<td>AETHENS</td>
<td>18810</td>
<td>12/16/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>AETHENS HEALTH AND REHABILITATION 200 SOUTH MAIN ST</td>
<td>AETHENS</td>
<td>18810</td>
<td>1/15/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>AETHENS HEALTH AND REHABILITATION 200 SOUTH MAIN ST</td>
<td>AETHENS</td>
<td>18810</td>
<td>1/5/18</td>
<td>686</td>
<td>Provide appropriate presure</td>
<td>E</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>AVALON SPRINGS PLACE</td>
<td>745 GREENVILLE ROAD</td>
<td>MERCER</td>
<td>16137</td>
<td>7/29/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>AVENTURA AT CREEKSDIE</td>
<td>45 NORTH SCOTT STREET</td>
<td>CARBONDALE</td>
<td>18407</td>
<td>8/3/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>2</td>
</tr>
<tr>
<td>PA</td>
<td>BARCLAYS FRIENDS</td>
<td>700 NORTH FRANKLIN</td>
<td>WEST CHESTER</td>
<td>19380</td>
<td>9/30/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>BARNES KASSON COUNTY HOSPITAL</td>
<td>2872 TURNPIKE STREET</td>
<td>SUSQUEHANNA</td>
<td>18847</td>
<td>3/2/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>BEACON RIDGE, A CHOICE COMM</td>
<td>1515 WAYNE AVENUE</td>
<td>INDIANA</td>
<td>15701</td>
<td>11/16/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>1</td>
</tr>
<tr>
<td>PA</td>
<td>BERWICK RETIREMENT VILLAGE NRS</td>
<td>801 EAST 16TH STREET</td>
<td>BERWICK</td>
<td>18603</td>
<td>8/11/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>E</td>
<td>2</td>
</tr>
<tr>
<td>PA</td>
<td>BETHLEM HM OF THE HUNGARIAN RF 66 CAREY SCHOOL ROAD</td>
<td>LIGNONIER</td>
<td>15658</td>
<td>1/28/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BIRCHWOOD HEALTHCARE AND REHA 395 MIDDLE ROAD</td>
<td>NANTICOKE</td>
<td>18634</td>
<td>5/19/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BIRCHWOOD HEALTHCARE AND REHA 395 MIDDLE ROAD</td>
<td>NANTICOKE</td>
<td>18634</td>
<td>6/10/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BRADFORD ECGEMICAL HOME, INC 100 SAINT FRANCIS DRIVE</td>
<td>BRADFORD</td>
<td>17601</td>
<td>5/25/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BRANDYWIN HALL</td>
<td>800 WEST MINER STREET</td>
<td>WEST CHESTER</td>
<td>19382</td>
<td>10/13/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>2</td>
</tr>
<tr>
<td>PA</td>
<td>BRIDGEVILLE REHABILITATION &amp; CAR 3590 WASHINGTON PIKE</td>
<td>BRIDGEVILLE</td>
<td>15017</td>
<td>6/12/18</td>
<td>686</td>
<td>Provide appropriate presure</td>
<td>D</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BRIGHTON REHABILITATION AND WEI 246 FRIENDSHIP CIRCLE</td>
<td>BEAVER</td>
<td>15009</td>
<td>7/11/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BRIGHTON REHABILITATION AND WEI 246 FRIENDSHIP CIRCLE</td>
<td>BEAVER</td>
<td>15009</td>
<td>3/23/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BROAD ACRES HEALTH AND REHAB</td>
<td>1883 SHUMWAY HILL ROAD WELLSBORO</td>
<td>16901</td>
<td>6/8/18</td>
<td>686</td>
<td>Provide appropriate presure</td>
<td>G</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BROAD MOUNTAIN HEALTH AND REH 500 WEST LAUREL STREET</td>
<td>FRACKVILLE</td>
<td>17931</td>
<td>8/19/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BROAD MOUNTAIN HEALTH AND REH 500 WEST LAUREL STREET</td>
<td>FRACKVILLE</td>
<td>17931</td>
<td>7/21/17</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>E</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BROOKMONT HEALTHCARE CENTER LI 510 BROOKMONT DRIVE</td>
<td>EFFORT</td>
<td>18330</td>
<td>10/19/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BROOKMONT HEALTHCARE CENTER LI 510 BROOKMONT DRIVE</td>
<td>EFFORT</td>
<td>18330</td>
<td>8/26/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BROOMALL PRESBYTERIAN VILLAGE</td>
<td>146 MARPLE ROAD</td>
<td>BROOMALL</td>
<td>19008</td>
<td>3/31/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>G</td>
<td>2</td>
</tr>
<tr>
<td>PA</td>
<td>BROOMALL REHABILITATION AND NU 50 NORTH MALIN ROAD BROOMALL</td>
<td>19008</td>
<td>10/5/18</td>
<td>686</td>
<td>Provide appropriate presure</td>
<td>D</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>BUFFALO VALLEY LUTHERAN VILLAGE</td>
<td>189 EAST TRESSLER BOULEV LEWISBURG</td>
<td>17837</td>
<td>9/4/18</td>
<td>686</td>
<td>Provide appropriate presure</td>
<td>D</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>CAMBRIA CARE CENTER</td>
<td>420 MANOR DRIVE</td>
<td>EBBINGEN</td>
<td>19281</td>
<td>4/18/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>CANTERBURY PLACE</td>
<td>310 FISK STREET</td>
<td>PITTSBURGH</td>
<td>18501</td>
<td>2/26/16</td>
<td>314</td>
<td>Give residents proper treatm</td>
<td>D</td>
<td>3</td>
</tr>
<tr>
<td>PA</td>
<td>CARBONDALE NURSING AND REHAB 10 HART PLACE</td>
<td>CARBONDALE</td>
<td>18400</td>
<td>6/14/18</td>
<td>686</td>
<td>Provide appropriate presure</td>
<td>D</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>CARING HEIGHTS COMMUNITY CARE 1320 CORPUSUS ROAD</td>
<td>CORPUSUS</td>
<td>15108</td>
<td>7/23/18</td>
<td>686</td>
<td>Provide appropriate presure</td>
<td>E</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Average: 15163.73482  Count: 3140  Sum: 18964996
These are just some of the examples of nursing home data available to you on www.nursinghome411.org

- All data are...
  - Free to download and use for your own information and advocacy
  - Formatted for ease of use
  - Searchable and sortable
  - Periodically updated
  - Derived from reliable resources (with citations provided)

To receive updates when new data are released and other alerts: https://nursinghome411.org/join/.
ProPublica’s Nursing Home Inspect
Nursing Home Inspect


Use this tool to compare nursing homes in a state based on the deficiencies cited by regulators and the penalties imposed in the past three years. You can also search over 60,000 nursing home inspection reports to look for trends or patterns. Here's our updated guide to making the most of this tool. | Related Story: Two Deaths, Wildly Different Penalties: The Big Disparities In Nursing Home Oversight.

Inconsistent Penalties Across the Country

Search for Terms Inside Nursing Home Deficiency Reports
A keyword, city, or nursing home name

About this Data
This app uses data from the U.S. Centers for Medicare and Medicaid Services. Fines are listed for the past three years if a home
Nursing Home Inspect
Find Nursing Home Problems in Your State

New York

624 Homes
62 Homes with Serious Deficiencies
$928K in Penalties
7 Payment Suspensions

Search for Terms Inside Nursing Home Deficiency Reports
A keyword, city, or nursing home name

About this Data
This app uses data from the U.S. Centers for Medicare and Medicaid Services. Fines are listed for the past three years if a home has made partial or full payment (fines under appeal are not included). Information on deficiencies come from a home's last three inspection cycles, or roughly three years in total. Special focus facilities, or homes flagged for having a history of serious quality issues, are marked with an ⚠️ sign.

<table>
<thead>
<tr>
<th>Nursing Home Name</th>
<th>City</th>
<th>Serious Deficiencies</th>
<th>Fines</th>
<th>Payment Suspensions</th>
<th>Total Deficiencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medford Multicare Center For Living</td>
<td>Medford</td>
<td>12</td>
<td>$128,389</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>Cayuga Ridge Extended Care</td>
<td>Ithaca</td>
<td>8</td>
<td>$130,488</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>Waterfront Center For Rehabilitation &amp; Healthcare</td>
<td>Buffalo</td>
<td>8</td>
<td>$100,000</td>
<td>47</td>
<td></td>
</tr>
<tr>
<td>Diamond Hill Nursing &amp; Rehabilitation Center</td>
<td>Troy</td>
<td>6</td>
<td></td>
<td>23</td>
<td></td>
</tr>
<tr>
<td>The Eleanor Nursing Care Center</td>
<td>Hyde Park</td>
<td>6</td>
<td></td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Focus Rehabilitation And Nursing Center At Otsego</td>
<td>Cooperstown</td>
<td>6</td>
<td></td>
<td>36</td>
<td></td>
</tr>
</tbody>
</table>

Deficiencies By Severity In New York
(What do the severity ratings mean?)

- B: 377
- C: 74
- D: 7,311
- E: 2,151
- F: 181
www.propublica.org: Example of simple search

10,584 results
(36,768 Deficiencies)

The number and severity of deficiencies shown below relate only to the search terms, not necessarily all deficiencies against the home.

Important: If you searched for a city or home name, results for that home may be spread over several pages. To improve results, select a state and sort by city.

<table>
<thead>
<tr>
<th>Date</th>
<th>Nursing Home</th>
<th>City</th>
<th>State</th>
<th>Def.</th>
<th>Severity Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>March 22, 2017</td>
<td>BROWNWOOD NURSING AND REHABILITATION LP (REPORT)</td>
<td>Brownwood</td>
<td>Tex.</td>
<td>1</td>
<td>L</td>
</tr>
<tr>
<td>Oct. 26, 2017</td>
<td>REUNION PLAZA SENIOR CARE AND REHABILITATION CENTE (REPORT)</td>
<td>Texarkana</td>
<td>Tex.</td>
<td>4</td>
<td>L</td>
</tr>
</tbody>
</table>

Deficiencies With "Discharge"

By Severity

This chart may display more deficiencies than reports because some reports have more than one deficiency. Click on each bar to limit search to that severity score.
Mapping Nursing Home Data in Your State or Community
Tableau: Mapping Nursing Home Ratings with Interactive Data Visualization Software

Eric Goldwein, MPH
Long Term Care Community Coalition (LTCCC)
Tableau: Mapping Nursing Home Data

**What is Tableau?**

- Interactive data visualization software which makes **maps**, **graphs**, and other **graphics** illustrating quantitative and qualitative information.
Not Just for Nursing Home Data ...

The Beatles

The Beetles

Most Common Insects Consumed Worldwide

- Beetles: 55%
- Butterflies and Moths: 20%
- Dragonflies and Damselflies: 15%
- Grasshoppers and Crickets: 10%
- Other: 2%

A recent editorial from Scientific American notes that this album is...
Concert Performances by UK Musicians (Post-2000)

2016 U.S. Election
Tableau Vocabulary

- **Tableau**
  - Interactive data visualization software.

- **Geospatial data**: Data or information that identifies the geographic location of features and boundaries on Earth (natural or constructed features, oceans, etc).

- **Coordinates**: *Latitude* (between -90° and 90°) *Longitude* (-180° and 180°).
  *Note: Negative values = West, South; Positive values = North, East.*
  - Crystal Gateway Marriott: 38.859° N, 77.055° W
  - The North Pole: 90.000° N
  - Liverpool, UK: 53.408° N, 2.992° W

- **Tableau Terms**
  - **Dimensions**: Fields that cannot be aggregated
  - **Measures**: Fields that can be measured, aggregated, or used for mathematical operations.
  - **Tooltips**: Details that appear when you rest the pointer over a data point.
  - **Worksheet**: Contains a single view along with shelves, legends, and the Data pane.
  - **Dashboard**: A collection of views from multiple worksheets.
A Map of the Map

- Coordinates
- Filters
- Variables
- Tooltip

Worksheet
Getting Started: Data, Data, Everywhere

Tableau is only as good as the information that is put into it.

- Data limitations: incomplete, misleading, inaccurate, poor quality.

Nursing Home Data: Found through Medicare.gov, ProPublica, other resources.

- Overall rating (1-5), Health Inspection, Staffing, Quality Measures, Special Focus Facility Status, etc.

While comprehensive, there are still limitations:

- **Under/overreporting**: Are surveyors capturing representative data?
- **Validity**: Do findings truly represent the phenomenon CMS is claiming to measure?)
- Others?

Still, NHC data can provide valuable insight nursing home performance.
1. Downloading data
   a. Visit [https://data.medicare.gov](https://data.medicare.gov), scroll down, and select “Nursing Home Compare data”
   
   ![Image of data download interface]

   b. Use search function to find dataset of interest – in this case, “Star Ratings.”
   c. Select Star Ratings and use the “Filter” feature to select data of interest.
      i. In this example, select the arrow next to Federal Provider Number and select “Provider State.” Type “MA” check small square next to text box.

   ![Image of filtering data]

   d. To download file, select Export → Download → CSV.

   ![Image of downloading process]

   e. Convert file from CSV to XLS and save to appropriate location.
2. Organizing spreadsheet
   a. Before using Tableau, we will want to organize our spreadsheet and create separate columns for Latitude and Longitude.
      i. Open file and identify column "Location." Extend column to see each facility's full addresses and geographic coordinates.
   ii. Create three new columns to the right of "Location." Move column labeled "Processing date" three columns to the right. The two empty columns to the right of "Location" will be for Latitude and Longitude.
   iii. Select Data ➔ Text to Columns ➔ Delimited ➔ Next.
   iv. On next screen, check “Other,” and type an open parenthesis “(“ and select finish.
   The spreadsheet will now display a separate column with the coordinates.
   v. Repeat process in 2a-ii to create separate columns for latitude and longitude. With new column highlighted, select Data ➔ Text to Columns ➔ Delimited ➔ Next. On next screen under “Delimiters,” uncheck “Other” and select “Comma.” Then click Finish.
   vi. Highlight column with longitudinal coordinates and use “find and replace” to eliminate parenthesis “)”.
   vii. Finally, label columns “Latitude” and “Longitude.” Save!

Page 2-3, Data entry for Tableau
Finding Missing Coordinates

3. Finding missing data
   i. Highlight top row and select filter. This allows you to sort each column.

   ![Sort excel columns](image1)

   ii. To identify facilities with missing coordinates, sort Latitude or Longitude
columns by smallest to largest (or largest to smallest) and scroll down to bottom
of dataset.

   ![Sort excel columns](image2)

   iii. To find coordinates, search facility or address on maps.google.com. Find
coordinates on URL and paste into excel. Repeat for all missing coordinates.

   ![Google Maps](image3)
Downloading Tableau Public

Tableau Instructions - 2019 Consumer Voice Conference
By Long Term Care Community Coalition

Downloading Tableau (Instructions via chadskelton.com/g/installing-tableau-public-and-open.html):

2. After file has been downloaded, run it and follow the prompts to install Tableau on your Mac or PC.
   a. On a PC, Tableau Public shortcut should be visible on your desktop. Double click it and

   ![PC Tableau Icon](image.png)

   b. On Mac, you may have to search for Tableau by double clicking search icon in the top right and typing in "Tableau". Next, drag the program into your dock and double click icon to load Tableau Public. Your screen should look like this:

   ![Mac Tableau Icon](image.png)
Tableau: Getting Started

Tableau Instructions - 2019 Consumer Voice Conference
By Long Term Care Community Coalition

1. Getting Started
   a. Open Tableau Public. Select Microsoft Excel on top left to add files. Select U.S. Nursing Home ratings and SFF status.xlsx

   ![Excel file selection](image)

   ![Excel file content](image)

   b. Excel files should include latitude, longitude, and variables of interest (e.g., Overall rating, Provider name, etc.)

   ![Excel file content](image)

   i. Note: Excel file should be checked for errors, missing datapoints, outliers, etc.

   c. Click Sheet 1 on bottom left, then right click Sheet 1 to rename (i.e., New York Nursing Home Ratings)

   ![Sheet rename](image)
2. **Creating Datapoints**
   a. On the left column there are two sections: 1) **Dimensions** and 2) **Measures**.
   b. Under Dimensions, select Provider State and drag into Filters shelf. Select state(s) of interest.
   c. Under Measures, find items labeled “Latitude” and “Longitude. Do NOT use items labeled “Latitude (generated)” and “Longitude (generated)” . Drag Longitude to Columns on shelf on top of map. Drag Latitude to Rows (below Columns).
   d. Under Dimensions, select Provider Name and drag into Detail in the shelf labeled Marks. The map will now display your state’s nursing homes and locations.
3. Illustrating Overall Ratings (by Color)
   b. To illustrate overall ratings by color, drag Overall Rating to Color (found in Marks shelf).
   i. Edit Colors and Legend title by hovering over Overall Rating on top right and selecting arrow.
   ii. Edit colors manually by assigning colors to each number or automatically assign colors by selecting Tableau’s Color Palettes.
   c. Rename values in Legend by right clicking value and selecting Edit Alias.

4. Illustrating Special Focus Facility (SFF) status (by Size)
   a. Under Dimensions, drag SFF Status to Size (found in Marks shelf).
   b. To edit legend (title, sizes), hover over SFF Status on top right and select arrow.
   i. To reorder Legend, select Manual and adjust items by preferred order.
   ii. To resize circles, select Edit sizes... and toggle Mark size range.
5. **Secondary Variables**
      i. When hovering over a nursing home, you will now see primary and secondary variables.

![Unedited Tooltip]

ii. To edit hover display, select Tooltip under Marks. Here, you can delete unwanted fields (Latitude and Longitude) and rearrange items (Moving up Provider Name, SFF Status, Overall Ratings).

![Updated Tooltip]
6. Finishing touches
   a. Map Layers
      i. Go to Map → Map Layers. Under Map Layers, select desired items (county names, county borders).
      
   b. Data Layers
      
   c. Title
      Double click title area to adjust size, font, text, etc.
      
   d. Search boxes
      To add a search box for facilities, click arrow next to “Provider Name” and select Show Filter. A list will appear to the right of the map, click dropdown arrow and select Single Value (dropdown) and then select Only Relevant Values to capture New York nursing homes. Now a dropdown menu should appear. Select (All) to show all facilities.
      
7. Publishing and embedding
   a. File → Save to Tableau Public. Once map is online, select share button on bottom right to find hyperlink and embed code.

Pages 7-8, Tableau Public Guide
Great job!
Questions?

Visit https://nursinghome411.org/mapping-information-on-nursing-home-quality-staffing/ for the instructions discussed in this program as well as links to Tableau and the NH Compare datasets.
Thank you once again.. We hope you’ve enjoyed the show!
Resources on www.nursinghome411.org
Alert: Illinois Poorly Performing Nursing Homes (September 2019)

The following alert provides information on the most poorly performing nursing homes in Illinois, as determined by their status as a Special Focus Facility, Special Focus Facility Candidate, or One-Star Facility. The alert includes […]

Alert: New York Poorly Performing Nursing Homes (September 2019)

The following alert provides information on the most poorly performing nursing homes in New York, as determined by their status as a Special Focus Facility, Special Focus Facility Candidate, or One-Star Facility. The alert […]

Alert: Pennsylvania Poorly Performing Nursing Homes (September 2019)
Advocacy Resources on www.nursinghome411.org
Welcome to LTCCC’s Learning Center. Below are our latest updates and materials. Click on the purple buttons to find fact sheets, webinars and other resources to support good care and resident-centered advocacy.

**LTCCC Webinar: The New Payment System for Nursing Homes**

**Fact Sheet: Nursing Home Therapy Services**

**Upcoming Webinars**

**LTCCC Webinar: The Impact of Staffing & Ownership on NY Nursing Home Quality**
The Dementia Care Toolkit

- What should I look for when assessing a facility?
- What should I see going on in my facility?
- What do we have a right to expect before drugs are given to a resident?
- What do we have a right to expect after drugs are given?
- And more!
The Dementia Care Toolkit

- Dementia Car Considerations
- Dementia Care Practices
- Dementia Care & Psychotropic Drugs
- Non-Pharmacological Approaches to Dementia Care
- Resident Dignity & Quality of Life
- Standards for a Safe Environment
- Resident Assessment & Care Planning
- Care Planning Requirements

- Informed Consent
- Resident & Family Recordkeeping
- Standards for People Providing Care
- Standards for Nursing Home Services
- Standard of Care to Ensure Resident Wellbeing
Family & Ombudsman Resource Center

Welcome to our dedicated Family & LTC Ombudsman page. We will be updating it frequently with resources and tools that you can use to support your resident-centered advocacy.

You can sign-up for updates by emailing info@ltccc.org or calling 212-385-0355. We would love to include you and support your efforts to improve care!

Fact Sheet: Nursing Home Therapy Services

LTCCC Issue Alert: Medicare Skilled Therapy Under PDPM
Forms & Tools For Resident-Centered Advocacy

The following forms and tools are free to use and share. They are available in both Word and PDF formats. Please choose the format which works best for you.

**Word files:**
- RESIDENT CONCERN RECORD KEEPING FORM
- RESIDENT ASSESSMENT WORKSHEET
- RESIDENT PREFERENCES FORM
- FAMILY COUNCIL MEETING NOTICE
- RESIDENT COUNCIL MEETING NOTICE
- RESIDENT COUNCIL MEETING AGENDA
- FAMILY COUNCIL MEETING AGENDA

**PDF files:**
- RESIDENT CONCERN RECORD KEEPING FORM
- RESIDENT ASSESSMENT WORKSHEET
- RESIDENT PREFERENCES FORM
- FAMILY COUNCIL MEETING NOTICE
- RESIDENT COUNCIL MEETING NOTICE
- RESIDENT COUNCIL MEETING AGENDA
- FAMILY COUNCIL MEETING AGENDA
LONG TERM CARE
COMMUNITY COALITION
WWW.NURSINGHOME411.ORG

Free Lunch & Learn Educational Programs:
Quality, Dignity, and Resident-Centered Advocacy

When Are The Programs? The third Tuesday of the month at 1pm Eastern.

October 15: The New Federal Nursing Home Payment System: Patient Driven Payment Model (PDPM)
The new federal payment system for nursing home care, PDPM, is going into effect in October. This program will review PDPM and discuss potential concerns for residents and families.

November 19: Recent Updates to Nursing Home Compare: Accessing Useful Information on Nursing Home Quality, Safety, and Staffing

December 17: Do You Have the Right to Expect More?: A Review of Recent Federal Studies on Nursing Home Quality, Safety, and Oversight
Too often, there is a disconnect between the promise of good care and residents’ experiences. This program will present highlights of recent federal reports that have assessed abuse, neglect, and oversight in nursing homes and the relevance of these reports to resident-centered advocacy.

January 21: Assessing the Humanity of Nursing Home Care: A Special Report From the Long Term Care Community Coalition

February 18: Using Data to Strengthen Your Nursing Home Advocacy

Attend Any Program in Two Easy Ways:
1) To join the online meeting, go to: https://join.freecall.com/richardmollot
2) To participate by phone, at the time of the program call (712) 770-4010. When prompted, enter the Access Code, 878277, followed by the pound (#) key.

Note: All program materials will be posted in the Learning Center at www.nursinghome411.org. To view the recording of the program, click on the YouTube button on our homepage.

Visit www.nursinghome411.org for...
Information on Staffing & Quality – Fact Sheets – Helpful Forms & Resources
Sign-up at https://nursinghome411.org/join/ to receive news and alerts.

You can also...

- Join us on Facebook: www.facebook.com/ltccc
- Follow us on Twitter: www.twitter.com/LTCconsumer
- Watch webinars on our YouTube channel: https://www.youtube.com/channel/UCSfczzeXNn5DS8EtECRskIQ/
- Listen to podcasts on Spotify, Apple, and Google Play. [Search “nursing home 411.”]
Thank You For Joining Us Today!

Questions?  Comments?